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Browse categories 

 
Ray Traced Studio enhancements 

ใหม่ Iray+ renderer แทนการใช้งานแบบ Author2 renderer การใช้ Iray+ renderer เติมเต็มการ
ใช้งาน CPU และ NVIDIA GPU ได้เต็มประสิทธิภาพ 

ผู้ใช้งานสามารถท าการแสดงผลด้วย photo-realistic interactive และ physically-based 
renderings ท่ีมีคุณภาพสูงขึ้น ซึ่งสามารถปรับค่าความสว่าง หรือความมืดในการแสดงผล และยังสามารถดูกา
การตกกระทบของแสงได้อีกด้วย 

 

การปรับรูปใน Iray+ renderer สามารถท าได้ ดังนี้: 

 ควบคุม rendering time โดยการก าหนดค่า time limit 

 Pause และ restart rendering process จนกระท้ังคุณพอใจผลของการ render 

 

ท าไมถึงควรใช้? 

การปรับปรุงช่วยให้คุณลดเวลาในการ render เพิ่ม process ในการควบคุม และท าให้ผลิตภัณฑ์
เสมือนจริงมากขึ้น 
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สามารถเข้าถึงค าสั่งได้อย่างไร 

Ray Traced Studio 

Prerequisites 

Windows 7 or higher 

An NX Render license 

To maximize rendering performance, an NVIDIA GPU with CUDA Compute Capability 2.0 
and higher, and a graphics driver supporting CUDA 7.0 or higher (For NVIDIA driver 
version, contact GTAC) 

Command 
Finder Ray Traced Studio  

 

Advanced Studio 

Prerequisites 

Windows 7 or higher 

An NX Studio Visualize license 

Command Finder Advanced Studio  
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Studio materials enhancements 
 

System Studio Materials 

ใน Version NX11 ได้มีการปรับปรุงเปล่ียนช่ือ palette ใหม ่เป็น System Studio Materials จาก

เดิม System Materials โดยใช้ palette ท่ีปรับปรุงขึ้นใหม่ในการสร้างการ render ท่ีมีคุณภาพ physically-

based สูงขึ้นใน Ray Traced Studio และ Advanced Studio ค่า default materials ใน Iray+ 

materials จะอยู่บนพื้นฐานของ NVIDIA Material Definition Language (MDL) โดยค่า materials จะ

รองรับค่าวัสดุท่ีคุณภาพสูงขึ้น อย่างเช่น การส่องผ่านของแสง ซึ่งคุณสามารถปรับแต่ง material ท่ีมีความ

ซับซ้อนได้ เพราะได้มีการออกแบบโครงสร้างของ material ประกอบกันเป็นช้ันๆ 

 

 

Studio Material Editor 

ใน Version NX11 ได้มีการเปล่ียนช่ือค าส่ังใหม่ คือ Studio Material Editor แทนท่ีค าส่ัง Material 
Editor โดยค าส่ังใหม่นั้นจะมีความสามารถในการสร้าง และแก้ไข MDL based Iray+ materials โดยการ
เลือก materials มาใช้ใหม่ และปรับปรุงคุณสมบัติของ materials อาทิเช่น color, layer และ roughness 

ซึ่งผู้ใช้งานสามารถ export ค่าท่ีผู้ใช้งานปรับปรุงขึ้นใหม่ไปยัง System Studio Materials palette และ
น าไปใช้ต่อได้ 
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Studio Materials in Part 

Palette ใหม ่Studio Materials in Part แทนท่ี Materials in Part palette 

Legacy system materials 

จากช้ินงานก่อนหน้านี้ NX จะแปลงระบบ material มาใช้รูปแบบใหม่แบบ Iray+ materials 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

System Studio Materials 

Resource bar System Studio Materials  tab 

Command finder System Studio Materials  

 

Studio Materials in Part 

Menu View→Visualization→Materials/Textures. 

Resource bar Studio Materials in Part  tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.facebook.com/dtmth


10 
www.dtm-thailand.com 
 

  www.facebook.com/dtmth   

 

System Scenes and Scene Editor enhancements 
 

ใน Version NX11 นี้ผู้ใช้งานสามารถใช้ค าส่ัง system scenes ซึ่งรองรับ Iray+ renderer  และบาง 
tabs , บางออปช่ันใน Scene Editor dialog box ก็ได้มีการเปล่ียนแปลง และจัดกลุ่มใหม่ ในส่วนของ tabs 
และออปช่ันท่ีไม่ได้น าไปใช้กับ Iray+ renderer จะถูกลบออก หรือซ่อนเอาไว ้

 

Pre-NX 11 NX 11 

Global Illumination tab Environment tab     (Renamed) 

Fit View to Stage check box Fit View to Ground check box     (Renamed) 

Size option     (Stage tab) Size option     (Environment tab) 

Offset option     (Stage tab) Offset option     (Environment tab) 

 

ท าไมถึงควรใช้? 

System Scenes 

Resource bar System Scenes   tab 

Command Finder System Scenes  

 

Scene Editor 

Command Finder Scene Editor  

Location in dialog 
box 

Environment tab→Ground Settings group→Ground Visibility check box, 
Ground Reflection check box, Size, Offset, and Fit View to Ground 

check box 
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Decal Sticker 
 

ใน Version NX11 ได้มีการเปล่ียนช่ือค าส่ังจาก Decal เป็น Decal Sticker โดยท่ีผู้ใช้งานสามารถท่ี
จะใช้การสะท้อนของผิวอย่างเช่น matte, plastic, หรือ mirror to a body เมื่อใช้ physically-based 
Iray+ materials ด้วยการเลือกใช้จาก Type ใน drop-down list 

สามารถเรียกค าสั่งได้ที่ 

Application Gateway, Modeling 

Prerequisite Studio rendering mode 

Command Finder Decal Sticker  

 
 

View a topic  (Automatic application change) 
 

เมื่อผู้ใช้งานท าการเปิดช้ินงาน NX ในเวอร์ช่ันนี้ จะท าการเข้าหมวดการท างาน application ท่ีท า
การ save ในครั้งล่าสุดให้ ซึ่งเมื่อผู้ใช้งานเปล่ียนการ displayed part, NX จะปรับ application ตามการใช้
งานปัจจุบันของช้ินงานนั้น ถ้ายังไม่ได้ก าหนดค่า application ในการท างาน NX จะท าการเปล่ียน 
application ตามการ save ช้ินงานครั้งล่าสุด 

 

Repeat Command list enhancements 
 

ในแต่ละ application และ task environment ยังคงใช้ Repeat Command list ของแต่ละ NX 
session การแสดงผลค าส่ังของ recently used ก็จะอ้างอิงตามแต่ละ application  เช่น ในกรณีท่ีผู้ใช้งาน
ปรับหมวดการท างานระหว่าง Modeling และ Sheet Metal เมื่ออยู่ในหมวดของ modeling ใน recently 
used ก็จะแสดงแค่ modeling จะไม่แสดงในส่วนของหมวดการท างาน Sheet Metal 

สามารถเรียกค าสั่งได้ที่ 

Prerequisite เฉพาะค าสั่งที่ปรากฏบน Ribbon bars หรือบน shortcut menus ถึงจะแสดงในแถบรายการ 

Quick Access toolbar Repeat Command list 

Shortcut menu Right-click in the background of the graphics window→Repeat Command 
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Changing displayed part enhancements 
 

ใน Version NX11 นี้ ผู้ใช้งานสามารถค้นหาช้ินงานท่ีเปิดไว้ได้ง่ายข้ึน ซึ่งเมื่อต้องการเปล่ียนไปเปิด
ช้ินงานอื่น NX จะแสดง preview ช้ินงาน, ช่ือ และค าอธิบาย หากมีการใส่ค่าไว้ ซึ่งการ preview จะสามารถ
ใช้ได้เมื่อผู้ใช้งานท าดังต่อไปนี้ 

 วางเมาส์บนแถบรายการของ  

Window Drop-down list. 

 

 

 

 

 

 

 กด Ctrl+Tab เพื่อเล่ือนหาภาพช้ินงานท่ีต้องการเปิด 
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นอกจากนี้ยังสามารถใช้ค าส่ัง Switch Window  บน Quick Access toolbar เพื่อเล่ือนหาภาพ
ช้ินงานท่ีต้องการเปิดได้อีกด้วย 

การเลือกเปิดช้ินงานใน Window → Change Displayed Part dialog box ผู้ใช้งาน
สามารถเปิด หรือปิดการ preview ช้ินงานใน Change Displayed Part dialog box ด้วยการใช้ Show 
Preview on Part Thumbnails in Dialogs ใน customer default 

 

Tip ท าการค้นหาใน customer default โดยเลือก File tab→ Utilities→Customer Defaults, 

และคลิก Find Default . 

 

สามารถเข้าถึงค าสั่งได้ที่ 

Command Finder 
Window  

Switch Window   
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Selection enhancements 
 

ใน Version NX11 นี้ผู้ใช้งานสามารถท่ีจะเลือกวัตถุหลายๆ ช้ินบนพื้นท่ีหน้าจอ โดยการวาดวงกลมรอบ
ช้ินงานท่ีต้องการ ด้วยขั้นตอนดังนี ้

 เลือกออปช่ัน Circle  Multi-Select Gesture หรือเลือก Circle Selection preference 

 การเลือกวัตถุ เมื่อใช้ Rectangle, Lasso หรือ Circle Multi-Select Gesture สามารถท าได้โดย
คลิกเมาส์ค้างไว้ แล้วเล่ือนครอบขอบเขตท่ีต้องการ 

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Command Finder 

Circle  

Lasso  

Rectangle  

Selection Preferences 

Location in dialog box 
Selection Preferences dialog box 

Multi-Select group→Mouse Gesture list→Circle 
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Support for STEP AP242 ISO standard data 
 

ใน Version NX11 สามารถเปิด File : STEP AP242 ISO standard data ใน NX และ save NX data 
เป็น STEP AP242 ได้ดังนี้ 

 STEP files (.stp) 

 STEP242 XML files (.stpx) 

 STEP242 compressed files (.stpz) 

 STEP242 compressed XML files (.stpxz) 

NX11 สามารถเปิดไฟล์ท่ีกล่าวมาข้างต้นได้เหมือนกับการเปิด file *.prt ตามปกติ  และสามารถเปิด
ไฟล์ .step ได้ แต่ไม่สามารถ save เป็น .step ได้  และสามารถ import ไฟล์ STEP AP242 standard 
ส าหรับ NX assembly ด้วยการเลือก File tab > Import > Part 

 

ท าไมถึงควรใช้ ? 

การปรับปรุง STEP AP242 standard เพื่อการท างานรวมกันของ NX และซอฟต์แวร์ CAD อื่นๆ 
หรือการแสดงผลของโปรแกรม ตามรูปแบบต่อไปนี้ 

 การเปล่ียนแปลงโดยเปิดการใช้งานค่าของ PMI ให้รองรับท้ังหมดเมื่อคุณเปิดหรือบันทึกไฟล์ 
step 

 STEP242 บีบไฟล์ให้มีขนาดเล็กลง โดยใช้รูปแบบไฟล์เป็น (.stpz) 

 STEP242 XML ไฟล์ format (.stpx) และ STEP242 compressed XML ไฟล์ format 
(.stpxz) ได้ปรับปรุงมาเพื่อรองรับการท างานในลักษณะ assembly 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Command Finder 
Open   , Save  

Save As   ,  Import Part 
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Linking attributes to expressions and other attributes 
 

ใน Version NX11 นี้ผู้ใช้งานสามารถท าการ link ข้อมูล attributes จากข้อมูลของ attributes อื่นๆ 
และค่าของ expressions ได้คล่องตัวมากขึ้น และยังสามารถใช้ properties dialog box เพื่อท่ีจะ 

 Link ค่า attribute จากค่า attribute อื่นๆ  ด้วยการใช้ออปช่ัน Insert in Formula 

 Link รูปแบบของ attributes ตามลักษณะของ expression ตามนี้ Number, Integer, Boolean 
หรือ String ด้วยการใช้ออปช่ัน Expression Formula 

 

Creating new attributes 
 

ใน Version NX11 นี้ ผู้ใช้งานสามารถสร้างช่อง attributes ขึ้นเพิ่มเติมในแถบของ Attributes เมื่อ
ต้ังค่าการใช้งานเป็นแบบ Bulk Edit สามารถท าได้โดยการคลิกขวาท่ี background ของ Attributes table 
และเลือก New Attribute ซึ่งก่อนหน้านี้ ผู้ใช้สามารถสร้าง attributes ขึ้นใหม่ได้เพียงแค่ต้ังค่าเป็นแบบ 
Traditional เท่านั้น 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Command Finder Properties  

Location in 
dialog box 

Attributes tab→Interaction Method = Traditional 

Attributes group→Expression Formula→right-click any node in the 

Attributes tree→Insert in Formula 

Attributes tab→Interaction Method = Bulk Edit 

Right-click any attribute→Expression Formula→right-click any 

attribute→Insert in Formula 

Right-click in the background of the Attributes table→New Attribute 
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Information window enhancement 
 

ใน Version NX11 เมื่อผู้ใช้งานเข้าค าส่ัง view information โปรแกรมจะแสดงผลของ 
Information ในรูปแบบของ HTML ซึ่งเมื่อผู้ใช้งานดูค่า information ของ component, NX จะแสดง
ข้อมูลตามรูป 
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Using NX on high density display devices 
 

ผู้ใช้งานสามารถปรับ NX Interface เพื่อให้รองรับกับจอท่ีเป็น 4K หรือมีค่าท่ีสูงกว่าใช้ High 
Definition presentation role ต้ังค่า Ribbon bar size เป็น 200%  และสร้าง icon ท่ีมีคุณภาพสูงขึ้นใน
ขนาด 128x128 pixel 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

High Definition role 

Resource bar Roles tab→Presentation category 

 
 

Viewing larger icons 
 

ในขณะนี้ คุณสามารถเพิ่มขนาดของ icons และ view clear และ sharp icons และ Ribbon bar 
ได้ถึง Extra Large (200%) ใน Customize dialog box 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Command Finder Customize  

Location in dialog box Icons/Tooltips tab→Ribbon Bar drop-down 
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Touchscreen gesture enhancements 
 

Action Gesture Description 

เลือก หรือยกเลิก
การเลือกวัตถุ 

 

แตะวัตถุ 

เลือกวัตถุหลาย
ช้ิน 

 

แตะค้าง และเล่ือนตามลักษณะท่ีก าหนด rectangle,  lasso หรือ 
circle ครอบวัตถุท่ีต้องการเลือก 

ยกเลิกการเลือก
วัตถุหลายช้ิน 

 

วางนิ้วหนึง่ไว้ที่ต าแหน่งอื่น และอีกนิ้วแตะค้าง และเล่ือนตาม
ลักษณะท่ีก าหนด rectangle,  lasso หรือ circle ครอบวัตถุท่ี
ต้องการเลือกออก 

 
Adding tooltips to dialog box favorites 

เมื่อผู้ใช้งานท าการ save a favorite ส าหรับ command dialog box จะสามาราถใส่ค่า 
description ซึ่งค่าดังกล่าวจะปรากฏขึ้นใน tooltip เมื่อวางเมาส์บนชื่อของ favorite บน Dialog Options 

 menu 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Location in dialog 
box 

Click Dialog Options on the dialog title bar→Save Favorite 
As 
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NEW MODELING COMMAND 

Renew Feature 

 ใน Version NX11 ผู้ใช้งานสามารถใช้ค าส่ัง Renew Feature เพื่อเพิ่มประสิทธิภาพของ Feature ท่ี
มีอยู่ ซึ่งเป็นคุณสมบัติของ NX ในรุ่นก่อนหน้า  ให้มีคุณสมบัติเป็นของ NX11 หรือรุ่นปัจจุบัน 
 เมื่อผู้ใช้งานท าการซ่อมแซม (Renew) คุณสมบัติของ Feature แล้ว ก็ยังท าการค านวนและสร้างอีก
ครั้งโดยอาศัย ข้อมูลรหัส (code) ของ NX11 ซึ่งจะสามารถท าได้รวดเร็วและถูกต้องกว่ารุ่นเดิม 
 แม้ว่า Renew Feature คือการเพิ่มประสิทธิภาพของ Feature ในท้ายท่ีสุด แต่ส่ิงท่ีเกิดขึ้นจะไม่ใช่
เพียงแค่การ Update 

ตัวอย่าง Feature ท่ีรองรับการใช้งาน Renew Feature 

 Edge Blend 

 Offset Curve in Face 

 Trim Body 

 Face Blend 

 Offset Surface 

 Blend Corner 

 Intersection Curve 

 Thicken 

 Draft Body 

 Law Extension 

 Trim and Extend 

 Fill Surface 

 Split Body 

 Variational Sweep 

 Trim Sheet 

 Combined Curve 
Projection 

  

โดยจะมีการเพิ่มเติม Feature ท่ีรองรับได้ ในอนาคต 

 Note : ในการซ่อมแซม Feature อาจจะมีข้อแตกต่างกันอันเนื่องมาจากคุณสมบัติท่ีมีอยู่
เดิมของ Feature ซึ่งในบางคุณสมบัติอาจยังไม่ได้รับการปรับปรุงท่ีถูกต้อง 

 Note :  ส าหรับ Feature ท่ีถูกสร้างขึ้นมาก่อนหน้า NX8.0 จะไม่ได้รับการสนับสนุนนี้ 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Feature Replay 

 ค าส่ัง Feature Replay มีการปรับปรุงเพื่อเติมประสิทธิภาพในการท างานในด้านการตรวจสอบ 
Model และการแก้ไข Model  โดยผู้ใช้งานจะสามารถท าได้ ดังนี้ 

 การทบทวน Feature ท่ีอาจจะเกิดปัญหาจาก Feature Replay และสามารถแก้ไขปัญหาท่ี
เกิดขึ้นได้เมื่อจ าเป็น โดย Feature นี้ และสามารถส่ังให้หยุดโดยอัตโนมัติได้ บน NX เวอร์
ช่ันปัจจุบัน 

 รูปแบบการปรับปรุงด้วยตนเอง โดยผ่าน Feature ของช้ินงาน 

 ใช้งานหรือหยุดช่ัวคราว และเลือก Feature เริ่มต้นส าหรับน าไปใช้ในค าส่ัง 

 ต้ังเวลาหรือช่วงเวลาส าหรับการท างานอัตโนมัติ 

** Note  : กดปุ่ม Play เพื่อใช้งาน Feature โดยสามารถ กด End เพื่อหยุดอย่างรวดเร็วในขณะท างาน
หรือเกิดการ Error 

Feature Replay ถูกน ามาแทนท่ีในค าส่ัง Feature Playback และ Automatic Feature Replay  
โดยค าส่ัง Feature Replay มีความสามารถท่ีจะทดแทนค าส่ังเดิมได้ คือ 

 มีความสอดคล้องในรูปแบบของการแก้ไข Model 

 รวดเร็วขึ้น (ส าหรับ Feature ท่ีสามารถใช้ร่วมกัน ) 

 เพิ่มการสนับสนุนการออกแบบแบบแยกช้ินส่วน ( Part Modules ) 

 สามารถ หยุด และ ท างานต่อ (Resume) เพื่อช่วยท าการแก้ไข Feature 

 ปรับปรุงประสิทธิภาพของ Interpart 

 ปรับปรุงฟังก์ช่ันการท างานให้สอดคล้องกับ Batch Tool ภายนอก 
 

ค าส่ัง Feature Replay จะมีประโยชน์อย่างมากส าหรับการแก้ไขช้ินงานท่ีได้รับมาจากภายนอก  โดย
จะช่วยให้คุณสามารถดูรูปแบบของการสร้างช้ินงานขึ้นมาได้ 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Isocline Curve 

 Isocline Curve เป็นค าส่ังที่ถูกน ามาแทนที่ Isocline Curve เดิมที่อยู่ในกล่องโต้ตอบของ
ค าส่ัง Extract Curve บน NX เวอร์ชั่นก่อนหน้า ซึ่ง NX11 ใช้ค าส่ังนี้เพื่อสร้าง Curve ที่สามารถ 
Constant กับ Surface โดยอาศัยการอ้างอิงด้วย Direction 

 ผู้ใช้งานสามารถ ใช้เส้นจาก Isocline Curve ท างานได้ดังนี้ 

 แบ่ง Surface ด้วยการ Split 

 สร้างทิศทางของมุมเอียงจากบน
ผิวงาน 

 สร้าง Parting Surface ส าหรับ
งานแม่พิมพ์พลาสติก หรือ งาน
หล่อ (Casting) 

 

ผู้ใช้งานสามารถเข้าถึง Isocline Curve จากงานที่ท าโดยเวอร์ชั่นก่อนหน้า NX11 แล้ว
น ามาท าการเปิดบน NX11 โดยสามารถใช้ค าส่ัง Isocline Curve ได้หลังจากท า Renew 
Feature 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Scale Curve 

 Scale Curve เป็นค าส่ังท่ีจะช่วยสร้างและก าหนดอัตราส่วนจากการคัดลอก เส้น (Curve) , ขอบ
ช้ินงาน (Edge Part) หรือ จุด (Point)  โดยผู้ใช้งานจะสามารถท าได้ ดังนี้ 

 สามารถท า Scale ท้ังแบบเท่ากันและไม่เท่ากัน โดยแยกการก าหนดแบบ XYZ ได้ 

 สามารถเก็บเส้นต้นแบบหรือซ่อนปิดได้ 

 สร้าง Feature ใหม่โดยท่ี มี หรือ ไม่มีการเช่ือมโยงใด ๆ ได้ 

 

โดยค าส่ังนี้มีความแตกต่างกันกับ Scale Curve ท่ีอยู่บนค าส่ัง Sketch ดังนี้ 

Scale Curve in Modeling Scale Curve in Sketching 

Creates a new feature Works within the sketch feature 

Scales in 3D Scales in the 2D sketch plane 

Scales uniformly or non-uniformly Scales uniformly 

Creates a copy of the curves Moves the selected sketch curves 

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Spline Curve 

  

ค าส่ง Spline Curve จะสามารถสร้างเส้น Spline ให้ “ต้ังฉาก” กับ Datum Plane ท่ีเลือกไว้ โดย
ในอนาคตจะทดแทนค าส่ัง “Spline” ท่ีมีอยู่เดิม 

โดยสามารถพัฒนามาใช้ร่วมกันกับ “Trim Surface” ด้วยวิธีการส่ังให้ต้ังฉากกับ Datum Plane ได้ 

และเมื่อมีการแก้ไข Plane ค าส่ัง Spline Curve จะท าการอัพเดทตามการแก้ไขนั้น ๆ 

 
 

สามารถเข้าถึงค าสั่งได้อย่างไร 

 
 

 

http://www.facebook.com/dtmth


26 
www.dtm-thailand.com 
 

  www.facebook.com/dtmth   

Swept Volume 

  

ใน Version NX11 ผู้ใช้งานสามารถใช้ค าส่ัง Swept Volume ในการน าเอา Solid Body มาใช้เป็น 
Tool เพื่อท าการ Sweep โดยการควบคุมแบบ Along Path โดยสามารถส่ังให้ Subtracts หรือ Intersects 
ร่วมกับ Target Body ได้ 

 

 

และยังสามารถก าหนดให้การ Sweep เป็นรูปแบบอื่น  ด้วยการใช้งานร่วมกับ Sweep Orientation 

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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COMMAND , TOOL AND SELECTION ENHANCEMENT 

 
Part Navigator enhancements 
 Part Navigator มีการเพิ่มเติมการแสดงผลตามข้อมูลของ Wave Link และ Product Interface 

 คอลัมน์แสดงสถานะของ Wave Link จะแสดงดังนี้ 

- สถานะการโหลดไฟล์งาน เช่น "Parent part" xyz.prt (Not loaded) 

- สถานะของ Feature เช่น Inactive หรือ Suppressed 

 คอลัมน์ Parent Interface ใหม่ มีการแสดงผลในส่วนของช่ือ Product Interface 

 New Link Folder ส าหรับใช้งาน 2 โฟลเดอร์ 2 ระดับ ในการเช่ือมโยงกับ Feature และ 
Expression 
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Optimize Face selection enhancement 
  

ผู้ใช้งานสามารถใช้ค าส่ัง “Find Interesting faces” ได้บนกล่องโต้ตอบของ “Optimize Face” 
ส าหรับท าให้คุณ สามารถเลือกผิวชิ้นงานได้อย่างรวดเร็ว เมื่อต้องการใช้งาน รวมถึงผิวทีไ่ม่ใช่การวิเคราะห์และ
ผิวที่ต่อกันโดยมีค่าของ Tolerance ระหว่างกัน 

 

 

ค าส่ัง Emphasize Faces and Edges จะท าให้สามารถก าหนดระดับความสนใจในวัตถุได้เป็น สูง
ท่ีสุด สูง หรือ ปานกลางได้ แต่ก่อนหน้านั้นจะต้องไม่ถูกเลือกรวมไว้ 

 การเพิ่มค าส่ังเข้ามาส าหรับการเลือกผิวบนชิ้นงานท่ีซับซ้อนโดยเฉพาะ ซึ่งจะท าให้คุณไม่ต้องใช้
เวลานานในการเลือกผิวเพื่อใช้งาน 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Delete Face enhancement 

  

ผู้ใช้งานสามารถใช้ค าส่ัง Delete Face ในการเลือกตัดผิวแบบ Single ของ Solid Body หรือ 
Sheet ท่ีมีการเช่ือมต่อกันอยู่ได้ 

 

 

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Hole enhancements 
 
Symbolic thread boolean enhancement 
 เมื่อผู้ใช้งานใช้ค าส่ัง Threaded Hole ในการเจาะช้ินงานโดยส่ัง Subtract เกลียวจะยังคงอยู่บน 
Target Body โดยท่ีไม่มีการส่ัง KeepTool ใน NX รุ่นก่อนหน้า โดยเกลียวจะหายไปเมื่อเราเลือก Keep 
Tool ท่ีกล่องโต้ตอบ 
 

Example Workfrow 

1. สร้างเกลียวบน Body แบบแยกช้ิน (Boolean = None)  

 
 

2. เกลียวจะถูกตัดลงถึง Target ท่ี 1 เมื่อเราเลือก Keep Tool 
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3. เกลียว (2) ถูกตัดเพียงบน Target 

 

 

Hole Depth Specification 

 ค าส่ัง Hole สามารถต้ังค่าก าหนดความลึกได้โดย 

Cylinder Bottom = ก าหนดจากส่วนของทรงกระบอก 

Cone Tip = ก าหนดจากความลึกของรูเจาะ 

  

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Face Blend enhancements 
  

ค าส่ัง Face Blend มีการเพิ่มเติมความสามารถข้ึนมา ดังนี้ 

 การแก้ไขใน Trim and Sew Option 

 ผลลัพมีความถูกต้องมากขึ้น เมื่อมีค่า R ของ Blend ท่ีแปรผันระหว่างผิวงานท่ีเกิด 
Segmented 

 Blend มีประสิทธิภาพมากขั้น ท้ังรูปร่างและรูปแบบการไหลของผิว ซึ่งจะเกิดการ Knot 
Point และ Segmented ท่ีน้อย 

 เพิ่มคุณภาพของการตัดขวางภายในของ Face Blend ซึ่งจะท าให้การ Offset หรือ 
Thicken จากผิวงาน 

 
 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Expressions enhancements 
  

ค าส่ัง Expressions ใน NX11 ได้มีการเพิ่มเติมในส่วนของ Layout เพื่อให้คุณสามารถ สร้าง , แก้ไข 
และ จัดการกับ Expressions ของคุณได้อย่างมีประสิทธิภาพ 

 

 

  

การเพิ่มเติมในส่วนกล่องโต้ตอบของ  Expressions จะปรากฏตัวแปรเพิ่มขึ้นมาท่ีจะท าให้ผู้ใช้งาน
สามารถใช้งานได้ ดังนี้ 

 แก้ไข ช่ือ และ สูตร ได้โดยตรงบนหน้าต่างของ Expressions 

 ท าการสร้าง , แก้ไข หน่วยหรือประเภท และน าออกไปแสดงยังคอลัมน์ใหม่ได้อย่างมี
ประสิทธิภาพ 

 การสร้างท าได้ง่าย เพียงแค่คลิกท่ีแถวที่จะท าการสร้างแล้วเริ่มพิมพ์ 
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นอกจากนี้ยังมีเครื่องมือส าหรับการกรองรายละเอยีด เพื่อให้ผู้ใช้งานสามารถค้นหา Expressions ท่ี
สนใจได้อย่างรวดเร็ว 

 

Design Logic List 

 เป็นตัวเลือกอ้างอิงของ Design Logic ซึ่งในตอนนี้จะเป็นแบบ Drop-Down โดยจะมีตัวเลือกค าส่ัง
ดังต่อไปนี ้

 Feature Parameter 

 Part Attribute 

 Object Attribute 

 Interpart Expressions 

ใช้การเช่ือมโยงเหล่านี้ เพื่อเข้าถึงตัวเลือกท่ีสามารถเข้าถึงได้ก่อนหน้า บนกล่องโต้ตอบของ 
Expressions เท่านั้น 

 

Create Single Interpart Expression 

 การท า Create Single Interpart Expressions กล่องโต้ตอบท่ีแสดงขึ้นมา จะท าให้สามารถเลือก
แหล่งท่ีมาของ Part และแหล่งท่ีมาของ Expressions บนกล่องโต้ตอบเดียว 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Trim Sheet enhancements 
  

เป็นการเพิ่มเติมความสามารถของค าส่ัง Trim Sheet คือ ขอบเขตของการ Trim จะสามารถต่อยืด
ออกไปได้เอง ท าให้เกิดขอบงานท่ีราบเรียบบน ผิวงาน หรือ ขอบเขตบนวัตถุ 

 

 

 
 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Replace Face enhancement 
  

ผู้ใช้งานสามารถใช้ค าส่ัง Replace Face บน Synchronous Modeling ส าหรับขอบเขตงานท่ี
ราบเรียบ ซึ่งเปิดกว้างขึ้นมากกว่าหนึ่ง หรือ Free Edges ท่ีไม่มีพื้นท่ีติดกัน 

  

จากตัวอย่างด้านล่างเป็นการใช้ค าส่ัง Replace Face ในการฉาย Open Edges (สีเขียว) ไปยังผิว
ภายนอก (สีเทา) 

 

 

  

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Edge selection enhancements 
  

ตัวคัดกรองในการเลือกเส้นหรือ Curve Rule มี 2 ตัวเลือกส าหรับการเลือกขอบงาน 
 

 Feature Intersection Edge ถูกน าเข้ามาเพิ่ม ส าหรับช่วยในการเลือกขอบงานท่ีผ่านการ
สร้างมาจาก Boolean เมื่อใช้ค าส่ังต่อไปนี้ 
 

Composite Curve 

WAVE Geometry Linker – Composite Curve 

Offset Curve in Face 

Face Blend* 

Project Curve 

Chamfer 

Studio Surface 

Through Curves 

Through Curve Mesh  

Trim Sheet  

Extend Sheet 

 

 

 ส าหรับ Sheet Edge จะถูกเพิ่มเข้าไปในค าส่ัง Trim Sheet 

 

ใช้ Curve Rule เพื่อช่วยเป็นตัวคัดกรองส าหรับการเลือกขอบงาน ท่ีมีอยู่บน Feature และ 
Sheet Edge ซึ่งเป็นส่วนหนึ่งของ Design Work Flow 
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Creating and reusing sketches 

 

NX11 ได้มีการเพิ่มรูปแบบของการ Sketch ท่ีเพิ่มข้ึน โดยสามารถจัดวางและเปล่ียนการ Sketch ไป
ยัง Plane อื่น ๆ ได้ง่าย ดังนี ้

Creating Sketching 

กล่องโต้ตอบของค าส่ัง Create Sketch ยังคงรูปแบบความเรียบง่ายส าหรับการใช้งานเสมอมา 

 ในปัจจุบันมีการเลือก Plane อยู่ 2 วิธี 

- ใช้โหมด Inferred ส าหรับการก าหนดระนาบ sketch อย่างรวดเร็ว   

- ใช้โหมด New Plane ส าหรับการก าหนดระนาบ Sketch เต็มรูปแบบ โดยควบคุมร่วมกับ 
Orientation และ Origin 

 
 

 สามารถก าหนดทิศทางของ Sketch Orientation ด้วยรูปแบบของ Vector ท่ัวไป 

 เพิ่มวิธีการเลือก Sketch Origin โดยสามารถระบุต าแหน่งด้วยจุดหรือเลือกระนาบผิวชิ้นงาน 

Sketching on Coordinatesystem 

 ผู้ใช้งานสามารถเข้าถึงค าส่ัง Sketch ได้อย่างง่ายดาย เพียงคลิกขวาท่ี CSYS โดย NX จะแสดงแถบ
ค าส่ังขึ้นมา ซึ่งมี Shortcut ของค าส่ัง Sketch อยู่บนแถบค าส่ัง 
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Reattaching Sketches to Different Planes 

 

กล่องตอบโต้ของค าส่ัง Reattach Sketch ได้มีการเพิ่มค าส่ังเช่นเดียวกันกับ Create Sketch เมื่อ
เรียกใช้ค าส่ัง Reattach Sketch จะมีค่าเริ่มต้นส าหรับวิธีการเลือก Skecth Plane แห่งใหม่ คือ “New 
Plane” 

สามารถเรียกค าสั่งได้ที่ 

Application Modelling , Assembly , Manufacturing 

Command Finder  

Sketch   

 

Sketch Task Environment 

 

Reattach Skecth 

 

Initially scaling a sketch  
 ในการ Sketch แบบปกติ จะท าการเขียนเส้นร่างก่อนแล้วจึงท าการก าหนดขนาดของรูปร่างท่ีเขียน
ลงไป โดยในรุ่นก่อนหน้านี้ เมื่อมีการเปล่ียนแปลงขนาดท่ีมีช่วงระยะกว้างมาก ๆ จะส่งผลต่อขนาดรูปร่าง
โดยรวมของ Sketch ซึ่งในรุ่นปัจจุบัน NX11 ได้ท าการปรับปรุงให้ผสมผสานกันของวิธีการก าหนดได้ท้ังแบบ
อัตโนมัติและด้วยตนเอง 

 

Scaling sketches automatically 

 เมื่อผู้ใช้งานเริ่มต้นก าหนดขนาดไปยัง Sketch ไม่ว่าจะเป็น ความยาว รัศมี หรือ เส้นผ่านศูนย์กลาง 
NX11 จะท าการปรับปรุง Scale ต่าง ๆ บน Sketch ให้สอดคล้องกันโดยอัตโนมัติ ท้ังในส่วนค่าขนาดต่าง ๆ 
และการก าหนด Geometric constraints 
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 การปรับปรุงรูปร่างแบบอัตโนมัตินี้ จะสามารถท าได้เพียงครั้งแรกที่ท าการแก้ไขขนาดของส่วนใดส่วน
หนึ่งเท่านั้น ส่วนการก าหนดขนาดในครั้งถัดไปจะเป็นการก าหนดแบบปกติ 

ข้อก าหนดก่อนการใช้งาน : 

 Sketch ควรอยู่ในรูปแบบเรขาคณิตท่ีจะสามารถท างานร่วมกับ 
Constraints ได้ดี โดยสามารถดูข้อมูลของ Constrains ได้ท่ีค าส่ัง 
Inferred Constraints and Dimension 

 ท าการตั้งค่า Sketch Preferences โดยให้เปิดค าส่ัง Scale on 
First Driving Dimension ก่อน 

 ไม่สามารถใช้ได้ใน Drafting Sketch บนหน้าการท างาน 

ของ 2D Component ในโหมด Drafting ได้ 

 ไม่สามารถใช้กับเส้นท่ีท าการ Geometric Constraints กับเส้นจากภายนอก ขอบช้ินงาน และ 
Datum Plane ได้ 

 ไม่สามารถท างานกับเส้นท่ีผ่านการผูกสูตรอยู่ 

ส าหรับการปรับปรุงรูปร่างด้วยตนเอง สามารถท าร่วมกับค าส่ัง 2D Synchronous Technology 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Driving dimension enhancements   

  

ส่ิงท่ีเพิ่มขึ้นมาใน Driving dimension คือ การแก้ไขแบบ Dynamic และท่ีดีกว่า คือ 
ผู้พัฒนาโปรแกรมได้แสดงเจตนารมย์ในเรื่องเกี่ยวกับการตรวจสอบการออกแบบ 

 

Driving dimension placement 

 เมื่อท าการแก้ไขรูปร่างบน Sketch โดย NX11 
สามารถท าการปรับปรุงมิติรูปร่างได้ ด้วยลักษณะการ
ท างานรูปแบบใหม่ จะช่วยท าการหา Geometry ในพื้นท่ี
ใกล้เคียงของเส้นรูปร่าง เพื่อใช้ในการปรับปรุงให้เกิด
ความสัมพันธ์กันระหว่าง Geometry 

Note : สามารถท าการก าหนดขนาดจาก NX รุ่นก่อน
หน้า ให้สัมพันธ์กับ Geometry , การแก้ไขมิติขนาดและ
การก าหนด Origin ใหม่ 

 

Adjusting dimension values dynamically 

 ผู้ใช้งานสามารถ “คลิกขวา” บน Driving Dimension 
เพื่อเข้าถึงหน้าต่างค าส่ัง Edit Parameters 

 ผู้ใช้งานสามารถใช้แถบเล่ือนท าการแก้ไขแบบไดนามิก  
เพื่อใช้ในการปรับปรุงค่าขนาดของเส้นรูปร่างบน Sketch 
ได้ 

 ผู้ใช้งานสามารถเปล่ียนไปท าการแก้ไข Dimensions อื่น 
ๆ ได้ เพียงท าการเลือก Dimension ท่ีต้องการ โดยไม่
จ าเป็นต้องออกจากกล่องโต้ตอบก่อน 
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User interface enhancement 

 การก าหนดขนาดบน Sketch เมื่อผู้ใช้งานเลือก Attachment Point จะปรากฏหน้าต่างแสดง 
Object on screen handle ขึ้นมา 

 
 หน้าต่าง Object on screen handle จะมีความสัมพันธ์กับการเลือก Object ในกล่องโต้ตอบของ 
Dimensions เพื่อให้คุณกลับไปเลือก Object ใหม่ได้ 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Auto dimension enhancements 
 

 ฟังก์ชันการท างานท่ีถูกเพิ่มเข้ามา จะมีประโยชน์อย่างมากต่อการท า Auto Dimensions 

 

Hide and show auto dimensions 

 หากผู้ใช้งานเริ่มรู้สึกเสียสมาธิกับ Dimensions บนช้ินงาน ผู้ใช้งานสามารถท าการ “ซ่อน” หรือ 
“แสดง” Dimensions เหล่านั้นได้ด้วยค าส่ัง “Display sketch auto dimensions option” 

 
 

Auto dimension placement 

 เมื่อผู้ใช้งานท าการแก้ไข Dimensions บนเส้นรูปร่าง ระบบ auto dimensions จะท าการขยับ
ต าแหน่งพร้อมกับน าพาเส้นรูปร่างบน sketch ไปด้วย ซึ่งจะช่วยลดความยุ่งเหยิงบนหน้าจอลง และท าให้
ผู้ใช้งานเข้าใจเส้นงานจากการเขียนได้มากขึ้น 

 
 ในรุ่นก่อนหน้านี้  ต าแหน่งของมิติรูปร่างต่าง ๆ จะเป็นแบบคงท่ี ซึ่ง NX จะท าการแสดงการ
เปล่ียนแปลงไปเฉพาะมิติท่ีปรับปรุงนั้น ๆ 
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 Adjusting auto dimension values dynamically 

 ใน Version NX11 สามารถแก้ไขขนาดของ Sketch ด้วยการคลิกขวาท่ี dimensions ท่ีต้องการแล้ว
เลือก Edit parameter จะปรากฏกล่องตอบโต้ขึ้นมา นอกจากนี้ยังสามารถใช้ แถบเล่ือน เพื่อท าการปรับ
ขนาดบน Sketch ได้ 

 
 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Sketch Relations Browser 
 

 Browser ใหม่ถูกเพิ่มเข้ามาใหม่ เป็นการใช้งานของ Constraint รูปแบบใหม่ 

 ค าส่ัง Sketch Relation Browser จะสอบถามความสัมพันธ์ของส่ิงต่าง ๆ บน Sketch โดยจะ
สามารถดูข้อจ ากัดของ Dimension , Constraint และการอ้างอิงต่าง ๆ เพียงแค่คลิกขวาท่ีวัตถุบน Sketch 
เพื่อแก้ไข  โดยผู้ใช้งานสามารถใช้ค าส่ังนี้แทนค าส่ัง Show/Remove Constraint ได้ 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

 
 

 
Perpendicular and tangent to string 
  

Perpendicular and tangent to string คือ ค าส่ังในการท าให้ต้ังฉากหรือสัมผัสกับเส้นแบบอื่น ๆ 

- Constraining to a string of recipe curves 

 

 

สามารถท า Constraint ของเส้น ร่วมกับเส้นท่ีสร้างมาจากค าส่ังอื่น ๆ เช่น Project Curve หรือ 
Intersection Curve  

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Horizontal and vertical alignment 
  

เป็นค าส่ังท่ีใช้ส าหรับการสร้าง Alignment บนแกนแนวนอนและแกนแนวตั้ง 

Align point 

 ผู้ใช้งานสามารถสร้าง Alignment ให้กับ “จุด” หรือ “ส่ิงท่ีใกล้เคียงกัน” ให้อยู่ในแนวระนาบ
เดียวกันใน “แนวนอน” หรือ “แนวตั้ง” อีกท้ังยังสามารถท า Constraint หรือ Dimension ได้โดยตรงกับจุด
กึ่งกลางของเส้นหรือส่วนโค้งได้ 

 

 

ท าไมถึงควรใช้ค าสั่งนี้ 

ในรุ่นก่อนหน้าของ NX จ าเป็นต้องใช้การเขียนเส้น Reference ขึ้นมาใช้ร่วมกัน ซึ่งใน NX11 จะ
สามารถท าการก าหนดได้โดยตรง โดยไม่ต้องอาศัยเส้น Reference 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Modifying sketch curves  
  

NX 11 สามารถท าการแก้ไขเส้นรูปร่างบน sketch ได้อย่างง่ายดายด้วยรูปแบบ Dynamic Drag 
(การดึงลาก) บนเส้นรูปร่าง 

 
 
Dragging curves 
 เมื่อท าการดึงลาก “เส้นโค้ง” โปรแกรม 
จะแสดงตัวอย่างของเส้นท่ีจะเกิดขึ้นจริง  
ซึ่งในรุ่นก่อนหน้าจะไม่มีการแสดงตัวอย่าง 

 
 
Dragging arcs 
 เส้นรูปร่างจะไม่พลิกไปมาขณะท่ีคุณลาก 

 

 

 

Editing constrained curves 

 สามารถแก้ไข Constraint ของเส้นได้ 

 ถ้าหากการแก้ไขนั้นไม่ส่งผลให้ Constraint  

ท่ีเป็นอยู่หายไป เพียง ดับเบิ้ลคลิก ท่ีเส้นนั้น  

ก็สามารถท าการแก้ไขได้ โดยท่ีในรุ่นก่อนหน้า 

ยังไม่สามารถท าได้ NX จะยังคงสภาพ constraint  

ท่ีถูกต้องภายหลังการแก้ไข 
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Creating sketch splines 
 

ผู้ใช้งานสามารถท าการควบคุม “จุด” บนเส้น Spline ได้ดีขึ้นกว่าเดิม ท้ังในรูปแบบการเขียนขึ้นใหม่
หรือการแก้ไขเส้นของ Spline ท่ีอยู่บนหน้า Sketch 

 
 Through Point          จะเป็นค่าเริ่มต้นส าหรับค าส่ัง Spline 

 เมื่อคุณสร้าง Spline  ในรูปแบบ Through Point คุณสามารถก าหนดให้การเช่ือมต่อจุด
ให้เป็นรูปแบบ G1 (Tangent) หรือการเช่ือมต่อจุดแบบ G2 (Curvature) 

 สามารถใช้งานค าส่ัง Non-Uniform Scale   ร่วมกับการเขียน Spline แบบ By Pole 

 Defining Point เป็นตัวเลือกท่ีถูกเพิ่มเข้ามาในการใช้งาน Snap โดยจะอยู่บน Border bar ซึ่ง
จะท าให้สามารถ Snap ได้ท้ังบน Curve และ Surface 

 เป็นค าส่ังท่ีช่วยในการสร้างหรือเลือกจุด ซึ่ง Spline Defining Point จะท าให้เป็นรายการ Point 
เพื่อท าให้สามารถเลือกจุดต่าง ๆ บนเส้นได้ 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Scale Curve 
  

ค าส่ังท่ีถูกเพิ่มเข้ามา เพื่อการใช้งานร่วมกับ 2D Synchronous ท่ีมีอยู่ใน Sketch ใช้เทคโนโลยี 2D 
Synchronous ร่วมกับ Scale Curve เพื่อท าการแก้ไขเส้นท่ีเลือกเองหรือท้ังหมด จากจุดอ้างอิง โดย NX จะ
ปรับปรุงเส้นท่ีอยู่ติดกันให้เปล่ียนแปลงตามไปด้วยอย่างอัตโนมัติ 
 นอกจากนั้นยังสามารถปรับปรุงแบบ Dynamic ด้วยค่าร้อยละหรือค่าคงท่ีอื่น ๆ ท่ีอยู่บนพื้นฐาน
ร่วมกัน เช่นเดียวกันกับค าส่ังอื่น ๆ การใช้ 2D Synchronous จะท าการเปล่ียนแปลงความสัมพันธ์ต่าง ๆ ท่ี
เกิดจาก Constraint หรือ Dimension ท่ีขัดแย้งกัน ให้เกิดความสมบูรณ์ 
 

 

 
 ค าส่ัง Scale Curve ยังสามารถใช้งานร่วมกันอยา่งมีประสิทธิภาพกับ 3D Curve , Part Edges และ 
Point ซึ่งสามารถน ามาประยุกต์ใช้งานบน NX Modelling ได้เป็นอย่างดี 
 

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Curve Finder enhancements 
  

Curve Finder มีส่ิงถูกเพิ่มเข้ามาช่วยให้การเคล่ือนย้าย ของกลุ่มเส้นบน Sketch สามารถคงสภาพ
ของเส้นไว้ได้ 

จากตัวอย่างด้านล่าง จะเห็นว่ามีเส้นรูปร่าง 2 กลุ่ม ท่ีแยกออกจากกัน โดยมีการสร้าง Constraint ไว้ 
คือ Collinear เมื่อท าการตั้งค่า Curve finder กับค าส่ัง Collinear โดยเลือกท่ีเส้นขอบบนสุดของรูปส่ีเหล่ียม 
กับเส้นแนวนอนด้านบนของอีกกลุ่มหนึง่ โดยอีกรูปหนึ่ง เมื่อท าการตั้งค่า Curve finder กับค าส่ัง Collinear 
Sketch Group จากนั้นท าการเลือกเช่นเดิม รูปส่ีเหล่ียมจะยังคงสภาพความยาวของรูปไว้ดังเดิม 

ซึ่งผู้ใช้งานสามารถควบคุมการเปล่ียนแปลงของรูปร่างได้อย่างรวดเร็ว  นอกเหนือจากการให้ 
Dimension 

 
  

สามารถเข้าถึงค าสั่งได้อย่างไร 
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Sketch features in the Part Navigator  
  

การแสดงผลของ Sketch Feature บนหน้าต่าง Part Navigator และ Context menus มีการแก้ไข
ปรับปรุงโดยรวมให้สอดคล้องกับ Sketch 

Context menus in the Part Navigator  

 Context menus มีการปรับปรุงแก้ไขเพื่อสนับสนุนการท างานรูปแบบใหม่ของ Sketch 

 ค าส่ัง Edit Parameter จะเปิด Sketch ขึ้นมาพร้อมกับกล่องโต้ตอบของ Edit Sketch 
Dimension เพื่อให้คุณสามารถแก้ไขขนาดมิติ 

 ค าส่ัง Make Datum Internal ถูกน าออก 

 ค าส่ัง Make Datum External ถูกน าออกไปใช้ใน New Sketch 

 

 

Displaying sketch dependencies 

 เป็นการดูความสัมพันธ์ของ Sketch Feature ท่ีบนหน้าต่าง Part Navigator ได้  แม้ว่า Sketch จะ
ไม่ได้ถูกใช้งานอยู่  โดยเปิดค าส่ัง Detailed View เพื่อดูรายการของ Sketch Plane , Reference Direction 
, Origin และ External Reference ต่าง ๆ ของ Sketch Feature 
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Sketch Preferences enhancements 
  

เป็นการตั้งค่า Sketch Preferences จะมีการเพิ่มเติมความสามารถของค าส่ัง เมื่อ Sketch มีขนาด
ใหญ่ขึ้นมากเพียงพอ NX จะท าการปรับปรุงแก้ไขตัวเลือกต่อไปนี้ ประสิทธิภาพมากขึ้นโดยอัตโนมัติ ดังนี้ 

 Create Inferred Constraint 

 Continuous Auto Dimensioning 

 Display Object Color 

 Display Vertices 

 Display Degree-of-Freedom Arrows 

โดยท่ีผู้ใช้งานสามารถเปล่ียนกลับมาใช้การตั้งค่าแบบด้วยตนเองได้ และการปรับปรุงนั้นจะส่งผลท า
ให้กล่องโต้ตอบของ Customer Defaults เปล่ียนเป็นตัวเลือกท่ีมีประสิทธิภาพ ซึ่งผู้ใช้งานสามารถปรับปรุง
ประสิทธิภาพของ Sketch ได้ง่ายข้ึนเพื่อรองรับการ Sketch ท่ีมีขนาดใหญ่ขึ้น 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Command Finder Sketch Preferences 
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Convergent Modeling 

  
 Convergent Modeling คือการท างานร่วมกันระหว่าง Facet Model และ Solid Model ซึ่ง

ผู้ใช้งานสามารถท าการ Import STL File เข้ามา แล้วน ามากระท ากับช้ินงาน Solid Model ได้เลย โดยแค่

ผู้ใช้งานเลือกใช้ค าส่ัง STL Import ตามปกติ จากนั้นท าการตั้งค่าในส่วนของ Facet Body Output Type 

ให้เป็น Convergent  
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 โดยหลังจากท่ีท าการ Import แล้ว ผู้ใช้งานสามารถใช้ค าส่ังได้ ดังต่อไปนี้ 

 หมวด Feature 

- Unite, Subtract, Intersect 

- Thicken, Offset Surface, and Offset Face 

- Extract Geometry & Link Geometry 

- Mirror Geometry, Pattern Geometry, Pattern Feature, Mirror Feature 

- Scale Body, Trim Body, Split Body, Trim Sheet, Divide Face 

- Extrude, Extend Sheet 

- Make Solid (a new command) 

หมวด Curve & Wireframe 

- Project Curve, Intersect Curve, Section Curve, and Advanced Fit. 

หมวด Edit 

- Move Feature, Move Object, and Transform 

หมวด Reverse Engineering 

- Snip Facet Body, Rapid Surfacing, Fit Surface, Fit Curve, Decimate, Subdivide Facet 
Body, Smooth Facet Body, Fill Hole, Merge Disjoint, Merge Overlapping, Merge 
Touching, Refit Face, Facet Body Curvature, Detect Primitives, and Paint Facet Body. 

หมวด Facet Specific Operations 

- Import STL as Convergent, Convert Facet Body, Facet Body from Body, and Export to 
STL. 

หมวด Analysis 

- Simple Distance, Simple Angle, Measure Distance, Measure Angle, Simple Length, 
Measure Extreme, Measure Face, Measure Body, Curve Analysis, Curve Continuity, 
and Examine Geometry. 

หมวด Assemblies 
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- Mirror Assembly, Create New (component selection), Find Component (by size), Open 
by Proximity, Define Product Outline, Show Product Outline, Replace Component, 
Advanced Weight Management, Add New Component, Reference Set automatic, 
Reference Set new, Make Unique, Assembly Cut, Move Component, Collision 
Detection, and Assembly Sequence 

 

Convert Facet Body 
 

 ส าหรับ Facet body หรือ STL ท่ี Import เข้ามาโดยไม่ผ่านการท า Convergent Model หรือได้มา
จาก NX Version เก่าท่ีไม่มีค าส่ัง Convergent Modeling นั้น ก็สามารถท าการ  Convert ได้โดยใช้

ค าส่ัง  Convert Facet Body  ซึ่งก็สามารถเลือกได้เช่นกันว่าจะเลือก Convertให้เป็นแบบไหน 

 NX 
 Convergent 
 JT 

 
 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Modeling 

Command Fincer Convert Facet Body  
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NX Realize Shape 
 Primitive Shape segmentation 

เป็นค าส่ังท่ีช่วยให้ผู้ใช้งานสามารถท าการปรับค่าของ Segment ของรูปร่าง Primitive shape ของ 
Realize Shape ได้ละเอียดมากขึ้น ดังนี้ 
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ส าหรับรูปร่าง Sphere นั้นจะถูกแยก

ออกเป็นกรณีพิเศษ คือ จะไม่สามารถท าการ

ปรับลดค่าของ Segment ได้ โดยจะท าการปรับ

ได้แค่ค่า Subdivsion levels ท่ีเป็นระดับ First 

และ Second เท่านั้น 

 

 
 
 
 
 
 
 

 

Subdivision Level = Base 

6 cage faces 

 

 

Subdivision Level = First 

24 cage faces 

 

 

Subdivision Level = Second 

96 cage faces 
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Assembly Navigator enhancements 
 

เป็นการเพิ่มประสิทธิภาพ ให้กับ Assembly Navigator ซึง่จะสามารถแสดงการสัมพันธ์ของ
ระหว่างค าส่ัง WAVE linker และ Product Interface information โดยจะแสดงให้เห็นในส่วนของ 
Column ช่ือ Out of Date. ดังนี้ 

 Frozen 

คือ แสดงให้เห็นถึงการเช่ือมโยงของช้ินงานนั้นไม่ได้ Update 

 Unknown 

คือ การแสดงผล ต่อไปนี้ 

 คุณสมบัติการเช่ือมโยงไม่สามารถเข้าถึงได้ 

 คุณสมบัติการเช่ือมโยงไม่ได้ใช้งาน 

 คุณสมบัติการเช่ือมโยงถูกระงับ 

 

 

Extraction Path enhancements 
 

เป็นการเพิ่มประสิทธิภาพของค าส่ัง Extraction Path ท่ีอยู่ในหมวด Assembly Sequence  โดย
ยังคงใช้ Dialog box เดิมอยู่ ซึ่งผู้ใช้งานจะสามารถปรับทิศทางของการเคล่ือนท่ีของช้ินงานได้ง่ายข้ึน สามารถ
ตรวจสอบการชนได้ง่ายข้ึน 

โดยผู้ใช้งานจะเห็นถึงการเคล่ือนท่ีท่ีนุ่มนวนมากขึ้น  

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Assemblies 

Prerequisite You must be in the Sequence environment. 

Command Finder Extraction Path 

Ribbon bar Home tab→Extraction Path 
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Limits on distance and angle assembly constraints 
 

 เป็นการเพิ่มประสิทธิภาพให้กับค าส่ัง assembly constraints แบบ distance และ angle โดยได้ท า
การเพิ่มตัวเลือกในการก าหนดค่า distance limits ซึ่งมีท้ังค่า Upper limit และ Lower limit  

ท้ังนี้ เพื่อช่วยให้ผู้ใช้งานสามารถท าการ Drag mouse เพื่อเคล่ือนท่ีช้ินงานได้สะดวกขึ้น โดยท่ีระยะ
นั้นจะไม่เลยระยะท่ีได้ต้ังค่าไว ้
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Reference pattern enhancements 
 

 NX11 ได้ท าการเพิ่มประสิทธิภาพของค าส่ัง Pattern Face, Pattern Geometry และ Sketch 
Pattern Curve โดยเมื่อมีการใช้ค าส่ังท้ัง 3 กับ Component ท่ีมี Constrain อยู่แล้วนั้น Constrain ก็จะถูก 
Copy ไปด้วยโดยอัตโนมัติ 
 
สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Assemblies 

Command Finder Pattern Component 

Menu Assemblies tab→Component group→Pattern Component 

Location in dialog box Pattern Definition group→Layout list→Reference  

 
 
 
 

Display Parent enhancements 
 
 NX11 Assembly ได้มีการปรับปรุงการแสดงรายการ Display Parent ใหม่ โดยได้ท าการจัดเรียงให้
เป็นระเบียบ และดูง่ายยิ่งขึ้น  ซึ่งเมื่อเทียบกับ Version เก่าแล้วนั้น จะเรียงแบบ Random 
 
สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Assemblies 

Assembly Navigator Right click the node of the displayed part→Display Parent list 
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Multiple start threading 
 

สามาราถก าหนด multiple starts ส าหรับ threading operations โดยในฟังก์ช่ันนี้รองรับการ
ท างานท้ัง tool ในรูปแบบ single-tooth และmultiple-tooth  

 

1 start for single or multi-tooth 
tool 

 

2 starts, tool has 2 teeth 

The tool cuts both threads at the 
same time. 

 

2 starts, tool has one tooth 

The tool must cut twice, once for 
each thread. 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Manufacturing 

Command Finder Thread Milling  

Location in dialog 
box 

Geometry group→Specify Feature Geometry →Feature group→Thread 

Dimensions→Number Of Starts 
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 Chamfer Milling enhancements 
ใน Version NX11 ผู้ใช้งานสามารถท่ีจะ 

 ระบุ tracking point ท่ีแตกต่างจาก drive point. 

 ควบคุมความลึกของ chamfer โดยระบุ drive point และค่า offset จากค่า minimum หรือ 
maximum diameter ของ modeled chamfer 

 

จากตัวอย่างแสดงการ chamfer ท่ีความลึก 1.5 mm 

 

Drive Point, Tracking Data point = SYS_CL_TIP (O) 

Chamfer Reference = Min Diameter 

Depth Offset = 1 

   

Drive Point = SYS_OD_SHOULDER (O) 

Tracking Data point = SYS_OD_SHOULDER (*) 

Chamfer Reference = Max Diameter 

Depth Offset = -1 
 

ถ้าท าการก าหนดค่า depth offset น้อยเกินไป NX ก็จะมี message ขึ้นเตือนให ้

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Manufacturing 

Command Finder  Hole Chamfer Milling  

Location in dialog 
box 

Select a tracking point to output 

 Non Cutting Moves→More tab→Cutter Compensation group→  

Output Contact/Tracking Data→Tracking Data 
Controlling the chamfer depth 

  Cutting Parameters→Strategy tab→Drive group→ Drive Point, 
Chamfer Reference, Depth Offset 
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Gouge and collision checking enhancements 
 

สามารถควบคุม gouge checking และ collision checking ได้อิสระมากขึ้นใน operations ดังต่อไปนี้  

  Radial Groove Milling 

  Hole Milling 

  Hole Chamfer Milling 
 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Manufacturing 

Location in dialog box 

[Hole machining operation] 

→Path Settings group 

    →Collision Check for Cutting, Gouge Checking 
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Top down ordering in area milling 
 

สามารถต้ังค่าการกัดของ cuts regions จากด้านบนลงด้านล่างได้ (highest to lowest) 

เมื่อเปล่ียนลักษณะของ steep containment เป็น Steep and Non-steep, NX จะแสดง Order Regions 
list ซึ่งมีอยู่ 2 ออปช่ันคือ 

1. Steep First 

ล าดับการท างานของ cut regions จะเป็นเหมือนกับเวอร์ช่ันก่อนหน้านี ้

2. Top Down 

ล าดับการท างานของ cut regions จะท างานจากบนลงล่าง (highest to lowest) 

 
 

ท าไมถึงควรใช้? 

ล าดับการท างานแบบ Top-down มีความจ าเป็นกับการกัดงานมาก คุณสามารถใช้ลักษณะการกัด
เช่นนี้ได้กับ tool อย่างมีประสิทธิภาพ  

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Manufacturing 

Prerequisite Use any operation that has the Area Milling drive method option. 

Location in dialog box Drive Method→Edit →Steep Containment group→Order Regions 
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Cleaning up follow periphery cuts in Area Milling 
 

เมื่อใช้ Follow Periphery ในการกัด Area Milling ไม่ว่าจะเป็น on plane หรือ on part 
บริเวณจุดกึ่งกลางของการกัดมักจะเหลือค่าของความละเอียดท่ีกว้างกว่าจุดอื่นๆ  

 

 

การลบเนื้อท่ีเหลือ โดยการแก้ไขรูปแบบของ drive method ท าได้โดย เข้าไปยัง Drive Settings 
และท าการเลือก Stepover Cleanup   
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 Stepover Cleanup  Stepover Cleanup 

 

 

Enhanced tool selection 
มีวิธีท่ีง่าย และมีประสิทธิภาพมากกว่าในการระบุ tool ท่ีจะใช้กับงานในแต่ละการท างาน  

เมื่อเลือกแก้ไข หรือสร้าง operation ขึ้นใหม่ สามารถ search หา tool ตามประเภทได้ 

เมื่อเลือก tool จะปรากฏค่า parameters และแสดงผล graphics window. 

 

ท าไมถึงควรใช้? 

การใช้ Tool Selection ช่วยให้ลดขั้นตอน และเวลาในการค้นหาจาก library ได้ การท างานใน
ลักษณะนี้จะเป็นประโยชน์อย่างมาก หากคุณสร้าง template และจัดหมวดหมูข่อง tool แต่ละรูปแบบ และ
ขนาดต่างๆ ท่ีต้องการน ามาใช้จริง 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Manufacturing 

Location in dialog box Tool group→Tool list→Browse 
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Area Mill drive method improvements 
 

ในขณะนี้ NX generate tool path ได้ระยะเวลาท่ีส้ันลง และคุณภาพของผิวดีขึ้น เมื่อใช้ Area Mill 
การเดินแบบ On Part  (การพัฒนานี้จ ากัดเฉพาะการใช้งานกับ ball end mills) 

 

 

Managing steep and non-steep regions 
 

มีการปรับปรุงการท างาน steep และ non-steep regions ใน Area Milling  

ใน NX เวอร์ช่ันก่อนหน้านี้ ถ้าหลายผิวที่เลือกตรงกับ steep angle ผิวก็จะแสดงการกัดเป็นสองแนวตามรูป
ด้านล่าง 

 

ใน NX 11.0 ทุกผิวจะแสดงการกัดเป็นแนวเดียวส าหรับจุดท่ีมี overlap ดังรูปท่ีแสดงด้านล่าง 
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5-axis toolpath improvements 
 

Multi-axis operations ท่ีใช้การท างานในรูปแบบ Streamline และ Surface Area ในขณะนี้
ท างานได้รวดเร็ว และสามารถ ONT gouge checker ได้ดียิ่งขึ้น 

 
 

Before After 

 

Cutting within enclosed areas with an angled head 

 

คุณสามารถใช้ T-cutter กับ right-angle หรือ 
adjustable-angle head ในการกัดบนเครื่องกัดแนวตั้ง 
ภายในพื้นท่ีปิด 

 

คุณสามารถท างานในลักษณะ multiple levels โดยมี 
limits อยู่ท่ีการก าหนดค่า clearance ส าหรับ tool และ 
head assembly 
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ข้อก าหนดเบื้องต้น 

Head: 

 Head ต้องเป็น model และสร้าง kinematic chain ใน Machine Tool Navigator 

 Operations: 

  Floor Wall 

  Floor Wall IPW 

  Face Milling with Boundaries 

  Face Milling Manual using the Mixed cut pattern 

 Tool: 

T-cutter 

 Cutting parameter: 

 Allow Undercutting 

 

Note ถ้าข้อก าหนดไม่ถูกต้อง ก็จะไม่มีการสร้างการกัด 

นอกจากนี้ ควรเลือก Check Tool and Holder  ถ้ามีการก าหนดค่าของ shank หรือ holder 
ไม่อย่างนัน้ค่าของ shank หรือ holder จะไม่ถูกน ามาเช็ค 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Manufacturing 

Location in dialog 
box 

[Operation] dialog box→Path Settings group→Cutting Parameters : 

 Strategy tab→Undercuts group→Allow Undercutting 

 Containment tab→Collision Checking group→Check Tool and 
Holder 
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Floor Wall milling profile cutting enhancement 
 

สามารถสร้าง tool path ในลักษณะควงลง (helical) ในการกัด vertical walls ในชุดค าส่ัง Floor 
Wall milling  

 

1 = Ramp angle 

2 = Depth per cut 

 

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Manufacturing 

Prerequisite A Floor and Wall Milling operation using the Profile Cut Pattern.  

Location in dialog box Floor Wall→Path Settings 
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Secondary Geometry representations 
  

เป็นการปรับต้ังค่าในหมวด Drafting ท่ีต้องการให้มีการเน้นให้เห็นถึงความชัดเจนของ Component ซึ่ง
จะท าการปรับให้ช้ินงานท่ีเราต้องการให้เด่นชัด (Primary Geometry) เป็นเส้นทึบ และช้ินงานอื่นๆ 
(Secondary Geometry) จะเป็นเส้นประ ตามรูปด้านล่าง 

 Primary Geometry (1) :The objects of focus. 

 Secondary Geometry (2) : The background or reference objects. 

 

 

 

 โดย Secondary Geometry จะสามารถปรับต้ังค่า Drafting preferences ได้อีกด้วย 

  

Hidden Lines 

Visible Lines 
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 ซึ่งเมื่อได้มีการท า Secondary Geometry แล้วนั้น ผู้ใช้งานจะสามารถตรวจสอบได้ว่า ช้ินงานไหน
บ้างท่ีเป็น Secondary Geometry โดยท าการ Add Column ในส่วนของ Assembly Navigator  

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Drafting 

Assembly Navigator Right-click a component node→Properties 

Location in dialog box Drawings tab→Secondary Geometry   check box 

 

ผู้ใช้งานจะสามารถปรับต้ังค่าของ Font , สี และความหนาได้อย่างไร 

Application Drafting 

Drafting preferences View→Common→Secondary Geometry node 

View settings Common→Secondary Geometry node 

 

ผู้ใช้งานจะสามารถปรับแก้ไขสถานะของชิ้นงานที่ต้องการท า Secondary Geometry ได้อย่างไร 

Application Drafting 

Shortcut menu Right-click a view border→Edit 

Location in dialog box Settings group→Secondary Geometry Components subgroup 
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 Arrangements on Drawings 

 เป็นการท าให้ผู้ใช้งานสามารถท าการปรับแก้ไข Arrangement ได้ โดยท้ังท่ียังคงอยู่ในหมวดการ
ท างาน Drafting ซึ่งจะสามารถปรับได้ใน View ดังนี ้

 Base 

 Projected 

 Standard (with Type set to Base View) 

 Independent detail 

 

 

 

โดยเมื่อผู้ใช้งานท าการปรับแก้ไขค่าของ Arrangement แล้วนั้น ก็จะปรากฏสถานะของ 
Arrangement ในส่วนของ Part Navigator ดังรูปด้านล่าง 
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สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Drafting 

Location in view dialog box Arrangement group→Arrangement to Use list 

Location in the View Creation Wizard Arrangement page→Arrangement to Use list 

 

สามารถเข้าถึงการแก้ไข Arrangement ได้อย่างไร 

Application Drafting 

Shortcut menu Right-click a view border→Edit 

Part Navigator Right-click a view node→Edit 

Location in an edit view dialog box Arrangement group→Arrangement to Use list 
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 Multithread processing for smart lightweight views 

 เป็นการเพิ่มประสิทธิภาพให้กับหมวดการวาง View แบบ smart lightweight view ด้วยการเปิด 
option พิเศษท่ีช่ือ Multithread processing ซึ่งจะมีผลท าให้ สามารถวาง view ท่ีมีขนาดใหญ่มากๆ หรือ
จ านวนช้ินส่วนท่ีเยอะมากๆ ได้อย่างดี และรวดเร็ว 

ส าหรับการเปิดการใช้งาน Multithread processing  สามารถท าได้โดยการ Setup ในส่วนของ 
environment variable ดังนี้ 

variable name : NX_DISABLE_DRAFTING_MULTITHREADING 

variable value : จ านวน Thread ท่ีต้องการเปิด 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

 

Application Drafting 

Graphics window 
While creating or editing a drafting view,  

right-click in the graphics window→Settings 

Location in dialog 
box 

Common→Configuration node→Settings group 

→Representation option→Smart Lightweight 
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 View Break enhancements 

 NX11 ได้มีการปรับปรุงค าส่ัง View Break ให้สามารถท าการตัด Section ซ้ าลงไปบน View Break 
นั้นๆ ได้อีกด้วย  

 

  

นอกจากนั้นยังได้ท าการ ปรับปรุงการบอก 

ขนาดความยาวที่ผู้ใช้งาน ได้บอกลงไปใน View Break 

 ให้เป็นแบบ Foreshortening Symbol ได้อีกด้วย 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Drafting 

Command Finder View Break  

Shortcut menu Right-click the view border→Add View Break 

Part Navigator Right-click the view node→Add View Break 
 

สามารถเข้าถึงการ Add Foreshortening Symbol to Dimensions ได้อย่างไร 

Application Drafting 

Location in dialog 
box 

View→Break node→Workflow group→Add Foreshortening 
Symbol to Dimensions 
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 Control selection of projected arcs 

Select Splines Projected as Arcs เป็นการปรับต้ังค่าของ View Preference เพื่อท่ีจะท าให้
ผู้ใช้งานสามารถก าหนดได้ว่า ต้องการให้ View ท่ีจะท าการวางลงไปนั้น สามารถหา Center ของขอบช้ินงาน
ท่ีเป็นเส้น Spline ได้หรือไม่ 

 

   

 

 

 

 Never : ไม่ท าการ Project spline curves 

 Never for Automatic : ไม่ท าการ Project spline curves กับ View ท่ีมีการวาง View แบบ
อัตโนมัติ 

 Always - ท าการ Project spline curves กับทุก View 
 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Drafting 

Command Finder Drafting Preferences  

Location in dialog 
box 

View→Workflow→General group→Select Splines Projected as 
Arcs 

Projected spline curves are  

not selectable 

Projected spline curves 

are selectable 
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 User interface enhancements for dimensions 

 เป็นปรับปรุงการแก้ไข Extension line ของ Dimension ให้สามารถปรับแก้ไขต าแหน่งได้ง่าย และ
สะดวกขึ้น 

   

 

 โดยเมื่อผู้ใช้งานกดเลือก Icon Edit   ก็จะสามารถท าการแก้ไข Extension line ได้ 

 
สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Drafting and PMI 

Prerequisite Create a new dimension or edit a retained dimension. 

Graphics 
window 

For new dimensions, the Object access handles immediately appear once 
you select the initial attachment points. 

For retained dimensions, the Extension Line access handles appear when 
you edit the retained dimension. 
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Inherit enhancements for dimensions 

  

เป็นการท าให้ผู้ใช้งานสามารถท าการ 

ถ่ายทอดคุณสมบัติ (Inherit) ของ Dimension  

ได้โดยการเลือกท่ี Select Dimension to Inherit   

ท่ีปรากฏอยู่บนหน้าต่างของค าส่ัง Dimension  

 

 

 

 

 

 

 

 

 

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Drafting and PMI 

Prerequisite Create or edit a dimension. 

Shortcut menu Right-click the dimension→Inherit 

Location in dialog box Settings group→Select Dimension to Inherit  
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Secondary depth dimensions for hole callouts 

 เป็นการเพิ่มค าส่ังในการบอกค่าความลึกของรูเจาะท่ีมี 2 ช้ัน เช่น รูเกลียว เป็นต้น โดยจะสามารถ
เลือกได้ว่าจะบอกเป็นแบบสัญลักษณ์ หรือบอกขนาดแบบ Dimension 

    

 

 
 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Drafting and PMI 

Prerequisite 

In the Linear Dimension or Radial Dimension dialog box, 

the Method group→Measurement option must be set to Hole Callout. 

In the Drafting Preferences dialog box or the Settings dialog box, 
the Depth parameter, Thread Depthparameter, or Length parameter 
must be set for the hole callout type. 

The component must be fully loaded in your NX session. 

Command 
Finder Linear Dimension   or Radial Dimension   

Graphics 
window 

While you create a hole callout, right-click and choose Create Secondary 
Dimension for Depth. 

Location in 
dialog box 

Measurement group→Create Secondary Dimension for Depth 

 

Create Secondary Dimensions for Depth 

option is not set 

Create Secondary Dimensions for Depth 

option is set 
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Limits and Fits enhancements 

 ใน Version NX11 ได้มีการปรับปรุงการก าหนดขนาดท่ีมีพิกัดความเผ่ือ , พิกัดงานสวม ดังนี้ 

 Format options 

 

 Display options 

 

 Split by Dimensions options 
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 Alignment options 

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Drafting and PMI 

Prerequisite 

Your units and drafting standards must be compatible with Limits 

and Fits . 

Graphics window Right-click a dimension→Settings  

Location in dialog 
box Tolerance preferences→Limits and Fits 
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Drafting preferences and settings enhancements 

NX11 ได้ท าการปรับปรุงการปรับต้ังค่าของ Drafting Preferences  ดังนี้ 

1. ได้ท าการย้ายค าส่ัง Version Up จากเดิมท่ีเคยอยู่ใน Drafting Preferences ไปเป็นค าส่ัง Version 

Up   แบบใหม่ท่ีอยู่ใน Ribbon bar ช่ือ Drafting Tools  

2. เพิ่มช่องส าหรับการแก้ไข Dimension แบบ Manual โดยใช้ค าส่ังช่ือ Override Dimension Text ท่ีอยู่

ในหมวด Format  ซึ่งจากเดิมจะต้องท าการกด Text Editor  . ก่อนจึงจะแก้ไขได้ 

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

 

Version Up command 

Application Drafting 

Command Finder Version Up   

 

Text box for manual dimensions 

Application Drafting 

Shortcut menu Right-click a dimension→Settings 

Location in dialog box Text→Format node→Override Dimension Text option 
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Advanced Flange enhancements 

 ผู้ใช้งานสามารถสร้าง Sheet Metal Flange ได้โดยการสร้างจาก Surface ได้โดยท่ี Surface นั้นไม่

ต้องตัดกัน 

 

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Sheet Metal 

Prerequisite 

The Start Edge Adjustment and End Edge Adjustment options are 
available only when you select the Flat Pattern Compensation at 
Start  check box, and the Flat Pattern Compensation at End  check 
box. 

Command 
Finder Advanced Flange  

Location in 
dialog box 

Settings group→[compensation options] 

Relief group→Corner Relief drop-down list→Bend Only and Bend/Face 

Flange Properties group→Length Reference drop-down 

list→Inside, Outside, Web, and DIN (6935) 
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Joggle 

 เป็นค าส่ังท่ีท าให้ผู้ใช้งานสามารถท าการสร้าง Joggle ได้โดยอ้างอิงจาก Plane ซึ่งท าให้ง่ายต่อการ

ระบุความสูงและระยะของ Joggle  

 

Joggle on a tab 

 

 

 

 

 

 

Joggle on a web face 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Sheet Metal 

Command Finder Joggle  
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Bounding Body 
 

NX11 ได้ท าการเปล่ียนช่ือค าส่ังใหม่ จาก Create Box เป็น Bounding Body โดยสามารถท่ีจะ 

 สร้าง box หรือ cylinder จากการเลือก faces, edges, curves, points, solids, sheet bodies 

หรือ facet bodies 

 แสดงขนาดโดยรวมของ box หรือ cylinder ท่ีสร้างบนหน้าจอได้ 

 ขยายขนาดของทุกแนวแกน โดยการเลือกดึงเพียงแนวแกนเดียว 

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Mold Wizard, Progressive Die Wizard, Electrode Design, Modeling, Manufacturing 

Command Finder 
Bounding Body  
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Extend Sheet in Mold Wizard 
เพิ่มค าส่ัง Extend Sheet ช่วยให้สร้าง parting surfaces  

 

ท าไมถึงควรใช้? 

ช่วยยืดผิวจากขอบของช้ินงาน เพื่อให้ผู้ใช้งานก าหนดค่า หรือท างานให้น้อย และรวดเร็วที่สุดในการ
สร้าง parting surfaces 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Mold Wizard, Progressive Die Wizard 

Command Finder Extend Sheet  
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Design Parting Surface enhancements 
 

มีการปรับปรุงการออกแบบ parting surfaces ดังนี ้

 Design Parting Surface 

 เปล่ียนจากค าส่ัง Trim and Extend เป็นค าส่ัง Extend Sheet  

 สามารถสร้าง single parting surface โดยไม่มีการ copy เพียงแค่เลือกออปช่ัน As Parting 
Surface 

 Edge Patch 

สามารถสร้าง single patch surface โดยไม่มีการ copy เพียงแค่เลือกออปช่ัน As Patch Surface  

 Edit Parting and Patch Surface 

สามารถเลือกสร้างในลักษณะ With Copies หรือ No Copies 

 Define Cavity and Core 

สามารถเลือกในลักษณการ Split Body ในการสร้าง cavity และ core ซึ่งจะช่วยลดขั้นตอนในการ
ตัด และเก็บข้อมลูช้ินงานในส่วนของช้ินงาน parting 

Parting objects ท่ีจะน าสร้างไว้ใน Parting Navigator . 

 Parting Surface 

 Patch Surface 

 Cut Solids 

 Split Body 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Mold Wizard 
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Define Positioning Feature 

 

ค าส่ัง Define Positioning Feature  ส าหรับสร้าง feature group ใน  sketch ในลักษณะ 
single หรือ multiple points ซึ่งสามารถท่ีจะสร้างจุดในลักษณะ linear, circular หรือ general pattern  

โดยคลิกค้างและลาก points เพื่อเปล่ียนต าแหน่ง วาง standard part จาก parts library หรือ a reuse 
object จาก reuse library ใน points  ท่ีสร้างขึ้น โดย standard part ท่ีน ามาวางจะ associative กับ 
point ท่ีเราสร้างขึ้นด้วย 

 

ท าไมถึงควรใช้? 

ใช้ค าส่ัง Define Positioning Feature ช่วยในการสร้าง concept design ในการวาง 
components  

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application 
Mold Wizard, Progressive Die Wizard,  

Engineering Die Wizard, Reuse Library 
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Standard Part Library enhancement 
 

สามารถคลิกค้างและลาก component จาก Reuse Library วางท่ีจุดของ positioning feature 
ช่วยในการสร้าง component pattern ได้ 

 

จากรูป แสดงการสร้าง positioning feature ในลักษณะ linear pattern  

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Mold Wizard, Progressive Die Wizard 

Command Finder Standard Part Library  

Prerequisite You must have a positioning feature defined within the current design 
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Runner and gate enhancements 
 

NX11 ได้มีการปรับปรุงในส่วนของ runners และ gates ดังนี ้

 Runner  

 สามารถสร้าง runner เป็น feature เดียว ใน Part Navigator . 

 สามารถสร้าง rounded end ในแต่ละ runner feature 

 สามารถก าหนดค่า offset เพื่อปรับ runner และสามารถก าหนดทิศทางในการ offset ได้ 

History Mode 

Model Views 

Cameras 

User Expressions 

Groups 

Model History 

Datum Coordinate System (0) 

Sketch (1) "SKETCH_000" 

Extrude (2) 

Sketch (3) "SKETCH_001" 

Runner (8) 

 

 

 Design Fill 

เปล่ียนเป็นค าส่ัง Design Fill แทนค าส่ัง Gate เมื่อใช้ค าส่ัง จะเป็นการเลือกใช้ gates และ 

runners จาก MW Fill Library ใน Reuse Library . 
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View Manager 

เปล่ียนต าแหน่งท่ีอยู่ของ View Manager ไปไว้ที ่Resource bar ซึ่งสามารถท่ีจะปิดการแสดง
ช้ินงาน , ปรับ reference set. , เปิดการแสดงผลหลายช้ินพร้อมกัน 
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Open area forming 
 

ผู้ใช้งานสามารถเลือกใช้ค าส่ัง Special Forming Insert  ในการสร้างรูปร่างของ Punch และ 
Die ท่ีเป็นแบบเปิด (Open Area) ได้ โดยผู้ใช้งานสามารถใช้ขอบของช้ินงาน ในการก าหนดค่า Overlap ของ
ก้อน Insert ได้ 

 

 

 

สามารถเข้าถึงค าสั่งได้อย่างไร 

Application Progressive Die Wizard 

Command Finder Special Forming Insert  
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Piercing Insert Design and performance improvements 
 

เป็นการเปล่ียน Dialog box ของค าส่ัง Piercing Insert Design ใหม่ เพื่อให้ผู้ใช้งานสามารถใช้ค าส่ังได้
สะดวกขึ้น โดยยังคงมีค าส่ังเหมือนเดิม แต่ได้เพิ่มค าส่ังช่ือ Special Piercing ส าหรับการท า Piercing Punch 
ท่ีมีรูปปร่างท่ีซับซ้อน 

 

 
 

 

 

 

 

 

 

 

NX10.0      NX11.0 

 

 

 

 

 

 

 


